
Introduction to Analytix/Cams
Welcome, and thank you for purchasing

Analytix/Cams. This design and analysis software has

the flexibility to allow you to start your design process

with follower requirements, or with an existing cam

profile.

Features Overview

Using Analytix/Cams, you can focus on optimizing

your cam and follower design rather than spending time

on tedious manual calculations.

Analytix/Cams also increases the reliability and

performance of your cam and follower designs by

providing the tools to analyze critical aspects of a

design before physical prototyping or production.

During the design process, Analytix/Cams immediately

provides graphical and numerical analysis of critical

data, such as cam profile, displacement, velocity,

pressure angle, radius of curvature, acceleration and

jerk.

Analytix/Cams supports convenient data input from

external sources through simple copy and paste

commands. You can also copy graphic illustrations in



the main window and paste them into other applications

for generating reports and presentations.

Supported Cams and Followers

Analytix/Cams supports the following basic cam and

follower types:

Plate cams with roller followers may be either external

or internal. With linear and barrel cams, either the top

or bottom cam surface may be modeled.

Plate Linear Barrel

Flat/Reciprocating                   x

Flat/Oscillating                          x

Roller/Reciprocating                x                 x                     x

Roller/Oscillating                     x                 x                     x





System Requirements

For the successful operation of Analytix/Cams, your

system should meet these requirements:

•

	

386 PC or greater

•

	

2 MB of available RAM

•

	

2 MB of free hard disk space (7 additional MB

required when also installing Analytix)

•

	

Windows v3.1 or later

Before You Begin

Before you use Analytix/Cams for a design project,

make sure you do the following:

•

	

Decide whether your design approach is based

on an existing cam, or based on follower

requirements.

•

	

Determine the general size of the cam and

follower parameters, such as base circle radius,

offset or follower radius.

This guide is written with the assumption that you

have knowledge of mechanical design and

cam/follower design principles in particular.



To learn more, consult the following recommended

books, which contain informative chapters on

cam/follower design:

•

	

"Design of Machinery," Robert L. Norton,

McGraw Hill, 1992.

•

	

"Kinematics and Dynamics of Machinery,"

Charles E. Wilson, J. Peter Sadler, Walter J.

Michels, Harper & Row.

•

	

"Theory of Machines & Mechanisms," J.E.

Shigley & J.J. Uicker, McGraw Hill, 1980



About This Guide

This guide is divided into two sections: Tutorial and

Reference.

Tutorial Section

•

	

Chapter 1 contains installation instructions.

•

	

Chapter 1 provides a brief overview of the

Analytix/Cams main window.

•

	

Chapters 2 and 3 explain the two approaches to

using Analytix/Cams:

Follower-to-Cam - You can quickly and easily

create cam profiles based on existing follower

requirements. In this mode, you can design a

cam from scratch. Once you have designed the

cam, you may want to investigate the follower

motion resulting from using the cam with a

different follower configuration. Any changes

you make to the follower geometry parameters

(such as follower offset, follower radius, and

follower arm length) affect only the cam profile.

Follower motion stays the same.



Cam-to-Follower - You have an existing cam

and want to design or derive the follower

motion. Using this design method you can input

the cam's coordinates and manipulate

parameters of the follower, such as follower

offset, follower radius, and follower arm length.

Follower kinematics are derived by the program.

•

	

Chapter 4 tells you how to integrate your design

with Analytix. Analytix is machine design and

simulation software with full animation,

kinematics and dynamic analysis capabilities

available from Saltire Software.

Reference Section

•

	

Chapter 5 explains the layout of the

Analytix/Cams main window and describes in

detail each of its components.



Chapter 1 - Quick Introduction to the Main Window

The Main Window

The Analytix/Cams main window contains four

sections you will use to create your cam and follower

designs. A brief description of each section is provided

below. For more detailed information, see Chapter 5.

The four sections of the main window are:

•

	

Tool Bar - A strip across the top of the window

containing the following buttons: Polar

Coordinates, Function, Follower-to-Cam and

Cam-to-Follower. The other items in the Tool

Bar relate to the Data Table and Cam/Follower

Configuration area.

•

	

Data Table - Provides numerical data on cam

profile, displacement, velocity, acceleration and

jerk (abbreviated in the Data Table as s, v, a, j).

This also provides a way to enter a cam profile

when in cam-to-follower mode.

•

	

Cam/Follower Configuration area - Select the

combination of cam and follower you are

designing and define geometric and numeric

input parameters in this area.



•

	

Analysis area - Examine various graphs while

defining the values and parameters for the cam

and follower.



Chapter 2 - Follower-to-Cam Tutorial

Follower-to-Cam Example 1

This first example walks you through a design using the

follower-to-cam approach. This means you can quickly

and easily create cam profiles based on existing

follower requirements.

In the follower-to-cam mode, use the Function window

to piece together a desired follower motion.

Alternatively, you can paste values for follower

displacement directly into the Data Table and

Analytix/Cams will automatically derive the cam

profile for you. Any modifications you make to the

follower parameters, such as follower offset, follower

radius, and follower arm length, will cause the cam

profile to change, but will not affect your defined

follower motion.

Example Requirements

In this example, you will design a plate cam with

external reciprocating roller follower. Due to design

constraints, such as clearances, the base circle radius is

5, the roller offset is .5 and the follower radius is 1.

The cam rotates counter-clockwise and the follower

offset is to the right.



¤

	

Note: You may use any units of length (meters, inches,

feet, etc.) as long as they are used consistently

throughout the input process. Angles are always

measured in degrees.

Between cam angle of 0 and 90 degrees the follower

has a full cycloidal rise to a displacement of 1.5;

between 90 and 180, a dwell and from 180 to 270

degrees a full cycloidal fall back to 0.

Setting Design Parameters

You can perform the following steps in any order, but

you must define each before you begin the "Entering

Data" section.

1

	

Click the Follower-to-Cam button in the Tool Bar.

2

	

In the drop-down menu in the Cam Configuration

area (in the right corner), select the combination of

cam and follower you are using. For this example,

select Plate-Reciprocating Roller.



¤

	

Note: As you select various options in this drop-down

menu, the illustration below it changes to correspond to

the type of cam/follower. The illustration does not

change as you make other modifications in this

configuration area.

3

	

Fill in the appropriate text box for the numeric input

parameters:

Base Circle Radius = 5

Offset e = .5

Follower Radius = 1

4

	

Click the Update button (which appears as a

graphical illustration to the right of the text boxes).

•

	

Click the desired button for the appropriate

geometric parameters:

Click the counter-clockwise button.

Click the offset to the right button.

Click the external follower button.

Now, you're ready to enter data.



Entering Data

1

	

In the top left corner of the data table, type 72 to

indicate the total number of data points to be

entered. This will allow input every 5 degrees (i.e.,

360 degrees/72 = 5) of cam angle.

For production designs, granularity of 1 degree or

somewhat finer is more typical. Click in the Cam

Angle column to update the degree increments in

this column.

2

	

Using the mouse to click and drag, select cam angle

0 to 90 to indicate a range of data to be input.

Alternatively, enter these values in Step 3.

3

	

Click the Function button.



The Function window appears.

Reposition this window by clicking and dragging its

title bar so you can see various portions of the

screen as you work.

4

	

In the Function window, select Cycloidal in the

drop-down menu.

5

	

Verify that the Initial Angle and Final Angle text

boxes are completed correctly.

This information is filled in automatically based on

the data range you highlighted in Step 2.



6

	

Type 0 in the "Initial s" and 1.5 in the "Final s" text

boxes.

•

	

Oscillating -When you're using oscillating

followers, displacement units should be in

degrees.

•

	

Reciprocating - When you're using

reciprocating followers, displacement units are

consistent with base circle radius and follower

radius.

7

	

At the top of the Function window, click the Full

Rise button. (Only the curves available for this type

of function are active.)

8

	

Click the Apply button in the Function window to

calculate the data for the range you specified.

Your Function window should now look like the

one below.



You can modify the data in the table by highlighting

the appropriate cells and typing the new values in

the Function window. Then, click Apply again.

9

	

Highlight the range of cam angles from 90 to 180

and select the Dwell in the Function window. (The

first and final displacements are equal.) Type 1.5 in

the "Initial s" field. Click Apply again.



10

	

Highlight the cam angle range 180 to 270 and select

Cycloidal in the Function window. Type 0 in the

"Final s" field. Click Apply again.



While defining the values and parameters for the

cam and follower, you can examine various analysis

graphs anytime in the Analysis area. See Chapter 5

for detailed information on the Analysis area.

At this point, your Analysis window with

Displacement selected should look like the one

below.



12

	

When you have finished your design, you can view

the cam digitally in tabular format in the Data

Table. Click the Polar to Cartesian button to toggle

between these two coordinate systems.

13

	

Select Save in the Analytix/Cams File menu to use

this data for use in the next chapter.



Follower-to-Cam Example 2

In this example, you will create a barrel cam, which

drives a reciprocating follower at a constant velocity of

0.2 inches/degree between 50 and 200 degrees.

Between 0 and 50 you will see a half rise cycloidal

function to smoothly blend in to the constant velocity

portion of the cam. Between 200 and 330 degrees, you

will use a 3-4-5 polynomial to bring the displacement

back to 0. If you have been working on the previous

example, select New in the File menu to start.

Setting Design Parameters

You can perform the following steps in any order, but

you must define each before you begin the "Entering

Data" section.

1

	

Click the Follower-to-Cam button in the Tool Bar.

2

	

In the drop-down menu in the Cam Configuration

area (in the upper right corner), select the

combination of cam and follower you are using.

For this example, select Barrel-Reciprocating

Follower.



¤   Note: As you select various options in this drop-down

menu, the illustration below it changes to correspond to

the type of cam/follower. The illustration does not

change as you make other modifications in this

configuration area.

3

	

Fill in the appropriate text box for the numeric input

parameters:

Cam Radius = 10

Cam Height = 40

Initial Y Coord. = 2

Follower Radius = 1



4

	

Click the Update button (which appears as a

graphical illustration to the right of the text boxes).

Now, you're ready to enter data.



Entering Data

1

	

In the top left comer of the table, type 72 to indicate

the total number of data points to be entered. This

will allow input every 5 degrees of cam angle (i.e.,

360 degrees/72 = 5).

2

	

Using the mouse to click and drag, select cells with

cam angle ranging from 0 to 50 to indicate a range

of data to be input. Alternatively, enter these values

in Step 3.

3

	

Click the Function button.

The Function window appears.

4

	

In the Function window, select Cycloidal in the

drop-down menu.

5

	

Click the Initial Half Rise button.

6

	

Verify that the Initial Angle and Final Angle text

boxes are completed correctly.

This information is filled in automatically based on

the data range you highlighted in Step 2.



7

	

Type 0 in the "Initial s," 5 in the "Final s" and 0.2 in

the "Final v" text boxes to match the constant

velocity. Analytix/Cams automatically supplies the

final value for displacement. Click Apply.

8

	

In the Data Table, use the mouse to select cells with

cam angle ranging from 50 through 200. In the

Function window's drop-down menu, select

Constant Velocity. Verify 50 in the Initial Angle

and 200 in the Final Angle text boxes. Type 5 in

the "Initial s" text box and .2 in the "Initial v" text

box. Analytix/Cams automatically supplies a value

of 35 for the final displacement. Click Apply.



9

	

Finally, create the final segment using a 3-4-5

polynomial between 200 degrees and 330 degrees of

cam angle. (Select these cells in the Data Table or

type the range of degrees in the Function window.)

This time, in the Function window specify the

following:

•

	

"Initial s" is 35 to match the final displacement

from the constant velocity segment.

•

	

The "Initial v" is .2 to match the constant

velocity segment.

•

	

"Initial a" is 0.



•

	

"Final s," "Final v," and "Final a" are all 0.

10

	

Click Apply.

At this point, your Analysis window with Velocity

selected should look like the one below.



11

	

To save your example for future use, select Save in

the File menu.



Chapter 3 - Cam-to-Follower Tutorial
In some cases, an existing cam must be modified

slightly, or follower motion redesigned or analyzed.

Analytix/Cams facilitates this task.

The example below assumes you have manufactured

the cam you designed in Chapter 2. Now you want to

redesign the follower system to meet new requirements

and see the effect on the follower motion.

In the cam-to-follower mode, you can change the x and

y coordinates. Other than this, any modifications you

make to the cam/follower parameters will cause the

follower motion to change, but will not affect your

defined cam.

If you have not saved the previous two examples, find

these examples on the Analytix/Cams disk as 
ex1.cam

and ex2.cam.

Example Requirements

In this example, you will use the cam profile data

generated in example 1 of Chapter 2. You can also use

your own data by typing it into the Data Table, copying

data from another source and pasting it into the Data

Table, or reading in a file containing the cam profile.



For example, you may have x,y data in a text file that

may have come from a computer-aided manufacturing

software package, or from a cam measuring instrument.

Setting Design Parameters

You can perform the following steps in any order, but

you must define each before you begin the "Entering

Data" section.

1

	

If you are using the data you saved in Chapter 2,

select Open in the Analytix/Cams File menu to open

that file.

2

	

Click the Cam-to-Follower button at the top of the

window. (Note that the cam coordinate columns

now appear first in the Data Table.) If you are using

the data you save in Chapter 2, go to Step 3 under

"Entering Data."

3

	

In the Cam/Follower Configuration area in the top

right corner of the window, select the appropriate

cam and follower combination of cam you are

considering.



Note: As you select various options in this pop-up

menu, the illustration below it changes to correspond to

the type of cam and follower combination.

4

	

Define the parameters of the cam and follower by

completing the text boxes in the Cam/Follower

Configuration area.

5

	

Click the appropriate geometric parameter buttons.

6

	

Click the Polar Coordinates button to specify input

coordinate system.

Now, you're ready to enter data.

¤

	

Note: If you are using the file loaded in the first

example, the data will already exist. Go to Step 3

below.



Entering Data

1

	

In the top left corner of the table, type the total

number of data points to be entered. Click in the

Cam Angle column to update the degree increments

in this column.

2

	

Add data to the Data Table in three ways:

•

	

Enter data manually by selecting a cell and

typing data into that cell.

•

	

Copy information from another source (such as

a spreadsheet) and paste it into the Data Table.

•

	

Open an ASCII file (either comma- or tab-

delimited).

¤    Note: If you're copying and pasting information, make

sure the source file is free of any extra characters, such

as commas or other punctuation. The x,y or r,6 data

must be in tab-delimited format with a return at the end

of each line. This is the default when copying and

pasting from a spreadsheet program. You need to

highlight the region of the Data Table you want to paste

information into before pasting.



The appropriate graphical information for the data

you entered appears in the Analysis area.



3

	

You can fine-tune cam coordinates by:

•

	

modifying the data in the Data Table and

viewing the resulting graphics in the Analysis

area.

OR

•

	

modifying parameters in the Cam/Follower

Configuration area.

Modifying follower parameters does not alter the

cam profile in this mode. It only modifies the

follower kinematics.



Chapter 4 - Integrating Cams Into Analytix
¤   Note: If you do not yet own Analytix, contact Saltire

Software for more information.

This chapter explains how to integrate your cam designs

into Analytix and provides two examples to help you

master the process. First, you should have a basic

understanding of how to use Analytix. Refer to the

Analytix Reference Manual as needed to use the

product.

In the two design approaches discussed in this guide,

you may be interested in analyzing the cam/follower in

the context of a larger mechanism. This may include

linkages, springs, dampers, cam "float," etc. To do this

mechanical systems analysis and simulation, use

Analytix v3.2 or later, which includes integration

features with Analytix/Cams.

You can import the cam profiles into Analytix and

actually animate the mechanism, driven by the cam.

Also, you can analyze torque on the cam shaft, motion

paths of attached machinery, forces on pins, clearances,

tolerances and so on.

Detailed instructions for using Analytix are found in the

Analytix Reference Manual. The information below

describes how to add a cam design to Analytix.



To add a cam to Analytix:

1

	

Open Analytix v3.2 or higher.

2

	

Select Add Cam in the Analysis menu.

Analytix/Cams opens.

3

	

Open an existing cam file or follow the instructions

in the previous chapters to create a cam.

4

	

Select the desired button for Follower-to-Cam or

Cam-to-Follower.

•

	

If you select the Follower-to-Cam mode, any

changes you make in Analytix to follower

parameters (such as follower arm length,

follower offset, etc.) will modify the cam

profile. The follower kinematics are preserved.

•

	

If you select the Cam-to-Follower mode,

changing follower parameters in Analytix will

preserve the same cam profile and adjust the

follower motion.

5

	

You can return to Analytix/Cams and make more

extensive modifications to the cam by double-

clicking the cam profile.

6

	

Exit Analytix/Cams and return to Analytix.



You should see your cam configuration in the

Analytix window. The cam and follower elements

are highlighted. (The default color is red.)

7

	

To rotate the cam/follower object:

•

	

Select the geometrical cam/follower objects to

be rotated. (Dimensions on their own are not

rotated, but follow the geometry.) These are

already highlighted.

•

	

Select Rotate in the View menu.

•

	

Click on the center of the rotation (such as the

center of the cam or the follower).



•

	

Position the cursor over a part of the

cam/follower to be rotated (away from the

center of rotation).

•

	

Click and drag the cam/follower. When the

cam/follower is correctly positioned, release the

mouse button.

You can change cam and follower dimensions

directly within Analytix with appropriate changes in

cam shape or follower configuration. When you

add a cam to a consistently dimensioned Analytix

session, the cam will appear in Analytix to scale.

This may require that you zoom out to view the

whole picture.

With all cams, two important dimensions are

specified in the Analytix model: the cam input

dimension and the follower displacement

dimension.

•

	

For plate and barrel cams, the input dimension is

an angle.

•

	

For linear cams, the input dimension is a

distance.

•

	

For oscillating followers, the follower

displacement dimension is an angle.



•

	

For reciprocating followers, the follower

displacement dimension is a distance.

Other dimensions in the model may represent

follower parameters.

Cams in Analytix

The graphics below represent the eight cam types as

they appear in Analytix.

Plate Cam - Reciprocating Flat Face Follower



Plate Cam - Reciprocating Roller Follower



Plate Cam - Oscillating Flat Face Follower



Plate Cam - Oscillating Roller Follower



Barrel Cam - Reciprocating Follower



Barrel Cam - Oscillating Follower



Linear Cam - Reciprocating Follower



Linear Cam - Oscillating Roller Follower



Integration With Analytix - Example 1

Now that you've gone through the tutorial that explains

how to integrate your cam into Analytix, you're ready

to plug in example data.

In this example, you'll see how to derive camshaft

torque for a cam in Analytix. Also, you'll learn how to

determine if and when the follower will lift or "float"

from the cam.

First, create the cam by following these steps:

1

	

In Analytix, select Add Cam in the File menu.

Analytix/Cams opens.

2

	

Click the Follower-to-Cam button in the Tool Bar.

3

	

In the drop-down menu in the Cam Configuration

area, select Plate-Oscillating Flat-Face Follower.

4

	

Fill in the appropriate text box for the numeric input

parameters:

Base Circle Radius = 5

Pivot AB = 10

Base Angle ABC = 30



Offset = 0

5

	

Click the Update button (which appears as a

graphical illustration to the right of the text boxes).

Now, you're ready to enter data.

Entering Data

1

	

In the top left corner of the table, type 72 to indicate

the total number of data points to be entered. This

will allow input every 5 degrees (i.e., 360

degrees/72 = 5).

2

	

Using the mouse to click and drag, select cells 0 to

240 to indicate a range of data to be input.

Alternatively, enter these values in Step 3.

3

	

Click the Function button.

The Function window appears.

4

	

In the Function window, select Modified Harmonic

in the drop-down menu.

5

	

Click the Single Dwell button.



6

	

Verify that the Initial Angle and Final Angle text

boxes are completed correctly. Also, make sure

"Initial s" is set to 0.

7

	

Type 15 in the Rise text box.

Your Analytix/Cams window with all settings

established should look like the window below:

8

	

Click Apply in the Function window.

9

	

Close Analytix/Cams and return to Analytix.



When placed into Analytix, this is how the cam and

follower system appears:

Making Modifications in Analytix

1

	

First, add a spring between the center of the cam

and the end of the follower arm. To do this, select

the two points and then use the Analysis/Add

Actuator menu.

2

	

Set the spring unextended length to 4 and the

stiffness to 3. Deselect Damper and Black Box.

Select both Tension and Compression. Click OK.



3

	

Complete the model by adding a moment of inertia

of 10 to the follower arm. To do this, double-click

the line representing the follower and fill in the

Inertia text box. Click OK.



¤

	

Note: In a more realistic model, you would also create a

point for the center of mass of the follower arm. This

example assumes the center of mass is at the pivot

point.

4

	

Camshaft Torque:

The cam shaft torque is represented by the reaction

torque in the cam angle (45 degrees in the above

diagram.) So, to graph the camshaft torque, graph

the reaction on this angle.



This reaction is positive (compression) during the

first 120 degrees of the motion (where the cam is

pushing against the spring) and negative in the next

120 degrees where the cam is being pushed by the

follower arm.

5

	

Follower Lift:

To detect follower lift or "float," examine the

reaction torque in the follower angle. This torque

should stay in compression if the follower stays in

contact with the cam. The faster the cam is rotating,

the greater the inertia forces due to the acceleration

of the follower arm and therefore the greater the

danger of the follower lift.

In this example, you will find the maximum angular

velocity at which this cam can be driven without

float occurring.



First, double-click the cam angle and set a unit

angular velocity.

The graph of the reaction on the follower angle

against cam angle looks like the window below:

This remains positive (compression) and therefore,

float does not occur.



Look now at the case where the cam velocity is 6

rad/sec:

The reaction is still all positive, but you see that it

dips strongly at 120 degrees. To find the velocity

where lift occurs, set the cam velocity to have a

variable value (v in this model), and set the cam

angle to 120 degrees to match the worse case.

Graph the follower angle reaction against velocity

for this worse case:



Read a solution off the graph, or alternatively, use

the Univariate Iteration tool to derive an accurate

value for v.

Hence, the maximum speed for this cam and

follower system without follower float is 5.81

rad/sec. 
You can then do "What if" analysis to vary

the geometry or the spring to optimize your design.



Integration With Analytix - Example 2

In this example, you learn how to build a model with

two cams working from the same axis, driving a

linkage.

Use the cam of the previous example to drive the

motion of an oscillating arm, and add a second cam

with a reciprocating roller follower.

1

	

Within Analytix, start with the previous model, but

increase the length of the follower arm to 25.

2

	

Analytix always locates its cams at the origin. To

avoid initial confusion, move the first cam away

from the origin before adding another cam. To do

this, select the existing model and use the

View/Move menu option.

3

	

Add a second cam by selecting Add Cam in the

Analytix File menu.

Analytix/Cams opens.

4

	

Click the Follower-to-Cam button in the Tool Bar.

5

	

In the drop-down menu in the Cam Configuration

area, select Plate-Reciprocating Roller.



6

	

Fill in the appropriate text box for the numeric input

parameters:

Base Circle Radius = 5

Offset e = 0

Follower Radius = 1

7

	

Click the Update button (which appears as a

graphical illustration to the right of the text boxes).

Now, you're ready to enter data.

Entering Data

1

	

In the top left comer of the table, type 72 to indicate

the total number of data points to be entered. This

will allow input every 5 degrees (i.e., 360

degrees/72 = 5).

2

	

Using the mouse to click and drag, select cells with

cam angle 0 to 240 to indicate a range of data to be

input. Alternatively, enter these values in Step 3.

3

	

Click the Function button.

The Function window appears.



4

	

In the Function window, select Modified Harmonic

in the drop-down menu.

5

	

Click the Single Dwell button.

6

	

Verify that the Initial Angle and Final Angle text

boxes are completed correctly.

7

	

Type 3 in the Rise text box.

Your Analytix/Cams window with all settings

established should look like the window below:



8

	

Click Apply in the Function window.

9

	

Close Analytix/Cams and return to Analytix.

When placed into Analytix, this is how the cam and

follower system appears:

Note that the model is under dimensioned. To be

consistently dimensioned, you need to dimension

the relative position and angle of the two cams.

In fact, in this model, the line of the action of the

reciprocating follower should be parallel to the base

direction of the follower arm. The base lines for the

two cams should be 120 degrees apart. Also, the

cam centers should be the same.

First, rotate and move the second cam into

approximately the correct location and orientation.



The model should be consistently dimensioned.

Driving Both Cams

Now, you see two cams, sitting on the same axis.

However, they each have their own driving angle.

To drive both cams together, link each angle to a

common parameter (in our case, parameter t).

1

	

First, give an initial value: In the Analytix

Calculator, set t=50.

2

	

Double-click the first cam's cam angle and set its

value to t.

3

	

Double-click the second cam's angle and set its

value to t.



	

4

	

Now, animate the double cam by setting the

parameter of the animation to t and let t vary from 0

to 360.

Creating a Linkage

1

	

Add and dimension a simple linkage between the

end points of the two followers. The linkage

consists of two lines drawn and dimensioned as

shown below.



2

	

Now, if you animate the cams as described above,

you see the linkage move.

¤   Note: The above example shows how cams may be

combined in Analytix and interlocking mechanisms

built on the cam models. Realistic models of greater

complexity may be built applying the same principles.



Chapter 5 - Detailed Description of the
Main Window

Below is the Analytix/Cams main window, which is

visible at all times.

Four main sections appear in the main window:

•

	

Tool Bar

•

	

Data Table

•

	

Cam/Follower Configuration area

•

	

Analysis area



Tool Bar

The Tool Bar contains four independent buttons.

The items on either side of these four buttons are

related to the Data Table and the Cam/Follower

Configuration area. These items are described later.

•

	

Polar Coordinates Button: This is a toggle that

selects whether the cam profile is in Cartesian or

polar coordinates.

•

	

Function Button: Click this button to see the

Function window for selecting cam profile curve

types.

•

	

Function Window: Allows you to choose the

type of curve between points when in the

follower-to-cam mode



The buttons at the top of the Function window

are:

Full Rise

First Half Rise

Second Half Rise

Single Dwell

Polynomial Spline

•

	

Follower-to-Cam Button: Click to indicate

your design approach is follower-to-cam.

•

	

Cam-to-Follower Button: Click to indicate

your design approach is cam-to-follower.



Data Table

The Data Table, shown below, provides numerical data

on displacement, velocity, acceleration and jerk

(abbreviated in the Data Table as s, v, a, j). You can

enter x and y or r and 6 data manually into each cell.

You can cut, copy and paste from a text editor,

spreadsheet or other Windows data, or you can have the

cam profile data synthesized by the application, using

the Function window and the Cam/Follower

Configuration options.

The Data Table contains vertical and horizontal scroll

bars for viewing data. The columns in the table allow

you to expand or reduce the width of a column by



clicking and dragging the horizontal bar separating each

column.

In the upper left corner of the table, you can specify the

total number of data points to be entered. These data

points appear in the far left column and represent the

degree values for which cam or follower data will be

entered. A greater number of data points allows for a

finer breakdown of degree intervals.

Studies of CNC fabrication by Norton and others

indicate that one half to one degree increments are

adequate for the design phase, even for high-speed

cams. Finer increments are not practical to

manufacture, even with CNC machine tools. Refer to

the recommended reading textbooks for more detail.

The system gives you the coordinates of the contact

point between the cam and follower when the cam has

rotated this number of degrees. The point is specified

with the cam resting at 0 degrees.

The relationship between cam angle and contact point

coordinate is as follows. Each point on the cam will be

in contact with the follower at some time in the cam's

motion. The cam angle gives the number of degrees the

cam has to turn for the point specified in this row of the

Data Table to be the contact point.



The point shown will be in contact with the follower

when the cam has rotated by the angle specified in the

Cam Angle column. Analytix/Cams stores the point

with the cam at 0 rotation so the polygon formed by

joining these points actually provides a cam profile.

For a linear cam, the Cam Angle column is replaced by

a Cam Displacement column. For a barrel cam, the x

coordinate is the angle of the barrel cam.

The items below appear as column headings in the Data

Table.

•

	

Cam Angle - Each row of the table represents

the relationship between the cam and the

follower at a specific moment in the motion of

the cam. The cam angle gives the number of

degrees the cam has rotated at that moment.

Note: For linear cams this will be a cam displacement

and the column heading will become Cam

Displacement.



•

	

s (Displacement) - This is the displacement of

the follower away from the base displacement.

(The base displacement is the location of the

follower relative to the base circle.)

•

	

v (Velocity) - The velocity of the follower

expressed in terms of cam angle. (Example: if

the cam angle is θ, v=ds/dθ)

•

	

a (Acceleration) - The acceleration of the

follower again in terms of cam angle a=dv/dθ.

•

	

j (Jerk) - The jerk (derivative of acceleration)

again in terms of cam angle j=da/dθ.



Below is a table of units for these quantities for

the different cam/follower types.

•

	

x (Cam Profile Coordinate) - Contact point x

coordinate. This is the point of contact between

the cam and the follower at the given cam angle.

For a barrel cam, the x coordinate column gives

Cam s v                   a                     j

Angle/

Disposition

Plate deg length length/deg      length/deg2     length/deg3

Recip.

Plate deg                 deg deg/deg         deg/deg2        deg/deg3

OSC.

Linear length           length length/length   length/length2   length/lengt3

Recip.

Linear length deg deg/length     deg/length2     deg/length3

OSC.

Barrel deg length length/deg    length/deg2      length/deg3

Recip.

Barrel deg deg                deg/deg       deg/deg 

2          deg/deg3

OSC.



	

the angle of the contact point on the cam

surface.

•

	

y (Cam Profile Coordinate) - Contact point y

coordinate. This is the point of contact between

the cam and the follower at the given cam angle.

•

	

r (Cam Profile Polar Coordinate) - Contact

point r coordinate. This is the distance (for a

given cam angle) from the point of contact

between the cam and follower and the center of

the cam base circle.

•

	

theta (Cam Profile Polar Coordinate) -

Contact point theta coordinate. This is the

orientation (for a given cam angle) of the line

from point of contact between the cam and

follower and the center of the base circle.

¤

	

Note: The contact points define the profile of the cam.

•

	

r.o.c. (Radius of Curvature) - r.o.c. gives the

radius of curvature of the cam at the contact

point.

•

	

Pressure Angle -Gives the angle between the

direction of motion of the follower and the

direction of the axis in transmission. For flat

face followers, the pressure angle is 0.



Cam/Follower Configuration Area

The Cam/Follower Configuration Area: Allows you to

select from a drop-down menu the combination of cam

and follower you are designing.

An illustration representing the cam and follower

combination appears below as you select from the

menu. Any special considerations for different cam and

follower types are identified below.

Plate - Reciprocating Flat Face

•

	

Base Circle Radius - This is the radius of

cam's base circle. (The follower has 0

displacement when it is lying on the base circle.)

• Buttons:

Clockwise/Counter Clockwise - Specifies

direction of the cam rotation, either clockwise or

counter-clockwise



•

	

Velocity Units - length/degrees

Plate- Reciprocating Roller

•

	

Base Circle Radius - This is the radius of

cam's base circle. (The follower has 0

displacement when it is lying on the base circle.)

•

	

Offset - The distance the follower is offset from

the line going through the axis of the cam.

•

	

Follower Radius - The radius of the follower

roller.

• Buttons:

Clockwise/Counter Clockwise - Specifies

direction of the cam rotation.

Follower Orientation - Specifies whether the

follower is oriented above or below the cam.

Internal/External Cam - Specifies whether you

want an external or internal cam (or the external

or internal surface of a slot cam).

•	 Velocity Units - length/degrees



Plate - Oscillating Flat Face

•

	

Base Circle Radius - This is the radius of

cam's base circle. (The follower has 0

displacement when it is lying on the base circle.)

•

	

Distance AB - The distance from the cam axis

to the pivot point of the follower.

•

	

Base Angle ABC - The angle between the

follower and the line between the cam axis and

the follower pivot when the follower lies on the

base circle.

•

	

Offset - The distance of the contact face of the

follower from the pivot arm. Positive offset is

in a direction toward the cam. Negative offset is

in a direction away from the cam.

• Buttons:

Clockwise/Counter Clockwise - Specifies

direction of the cam rotation.

Follower Orientation - Specifies whether the

follower is oriented above or below the cam.

•

	

Velocity Units - degrees/degrees



¤

	

Note: Changing the base radius of the cam

automatically changes the base angle.

Plate-Oscillating Roller

•

	

Base Circle Radius - This is the radius of

cam's base circle. (The follower has 0

displacement when it is lying on the base circle.)

•

	

Distance AB - The distance from the cam axis

to the pivot point of the follower.

•

	

Base Angle ABC - The angle between the

follower and the line between the cam axis and

the follower pivot when the follower lies on the

base circle.

•

	

Arm BC - The distance from the follower pivot

to the center of the roller.

•

	

Follower Radius - The radius of the follower

roller.

• Buttons:

Clockwise/Counter Clockwise - Specifies

direction of the cam rotation.



Follower Orientation - Specifies whether the

follower is oriented above or below the cam.

Internal/External Cam - Specifies whether you

want an external or internal cam (or the external

or internal surface of a slot cam.)

•

	

Velocity Units - degrees/degrees

¤   Note: Changing the base radius of the cam

automatically changes the base angle.

Barrel - Reciprocating Follower

•

	

Cam Radius - The radius of the barrel cam.

•

	

Follower Radius - The radius of the follower

roller.

• Buttons:

Barrel Rotating Left/Right - Specifies the

direction of the cam. Indicates whether the

active surface of the barrel cam is moving to the

right or to the left when the cam is rotating.

Upper/Lower Cam Surface - Indicates whether

the cam surface is on the top or bottom.



•

	

Velocity Units  - length/degrees

¤

	

Note: The x coordinate is the angle on the barrel cam

measured in degrees.

Barrel - Oscillating Follower

•

	

Cam Radius - The radius of the barrel cam.

•

	

Follower Radius - The radius of the follower

roller.

•

	

Follower Arm - The length of the follower arm

from the pivot point to the center of the roller.

•

	

Pivot X Coord. - The x coordinate of the pivot

point. (The leading edge of the rectangle

representing the cam is assumed to start at x

coordinate 0.) A positive value for x positions

the pivot to the right of the cam. A negative

value positions the pivot to the left of the cam.

•

	

Pivot Y Coord. - The Y coordinate of the pivot

point. Y is measured from the base of the cam.

•

	

Initial Angle - The initial angle of the follower

arm (measured counter-clockwise from the



positive x axis). Angular displacements are

measured with the initial angle as 0. Positive

displacements represent counter-clockwise

rotation of the follower.

• Buttons:

Barrel Rotating Left/Right - Specifies the

direction of the cam. Indicates whether the

active surface of the barrel cam is moving to the

right or to the left when the cam is rotating.

Upper/Lower Cam Surface - Indicates whether

the cam surface is on the top or bottom.

•

	

Velocity Units - length/degrees

¤

	

Note: The x coordinate is the angle on the barrel cam

measured in degrees. The pivot x coordinate can be

positive or negative. The initial angle is the initial

angle of the follower measured from the positive x axis.

Linear - Reciprocating Follower

•

	

Cam Width - The width of the cam.



•

	

Follower Radius - 
The radius of the follower

roller.

• Buttons:

Linear Sliding Left/Right - Specifies the

direction of the cam, either left or right.

Upper/Lower Cam Surface - Indicates whether

the cam surface is on the top or bottom.

•

	

Velocity Units - length/length

¤

	

Note: Instead of cam angle, you see cam displacement.

Linear-Oscillating Follower

•

	

Cam Width - The width of the cam.

•

	

Follower Radius - The radius of the follower

roller.

•

	

Follower Arm - The length of the follower arm

from the pivot point to the center of the roller.

•

	

Pivot X Coord. - The x coordinate of the pivot

point. (The leading edge of the rectangle

representing the cam is assumed to start at x



coordinate 0.) A positive value for x positions

the pivot to the right of the cam. A negative

value positions the pivot to the left of the cam.

•

	

Pivot Y Coord.  - The Y coordinate of the pivot

point. Y is measured from the base of the cam.

•

	

Initial Angle - The initial angle of the follower

arm (measured counter-clockwise from the

positive x axis). Angular displacements are

measured with the initial angle as 0. Positive

displacements represent counter-clockwise

rotation of the follower.

• Buttons:

Linear Sliding Left/Right - Specifies the

direction of the cam, either left or right.

Upper/Lower Cam Surface - Indicates whether

the cam surface is on the top or bottom.

•

	

Velocity Units - degrees/length

¤

	

Note: Instead of cam angle, you see cam displacement.

The pivot x coordinate can be positive or negative. The

initial angle is the initial angle of the follower measured

from the positive x axis.



Analysis Area

At any time while defining the values and parameters

for the cam and follower, you can examine various

graphs in the Analysis area. (This appears in the lower

right portion of the main window.)

The drop down menu in the Analysis area provides

views of the following properties:

¤

	

Note: In the case of an oscillating follower type,

displacement is angular.



You can also copy to the Windows Clipboard the

illustration that appears in the Analysis area by clicking

the Clipboard button.

This is useful for pasting data into other applications for

creating project documentation, proposals,

presentations and reports.

Two methods are provided for viewing displacement,

velocity, acceleration and jerk, pressure angle and

radius of curvature: in tabular format in the Data Table

or in graphical format in the Analysis area. The

numeric values for the illustration appear in the

corresponding columns of the table.



Chapter 6 - Analytix/Cams Menu Reference
You see three menus in the Analytix/Cams menu bar:

File

New - Displays a new Analytix/Cams window

where you can create a new design.

Open -Displays an Open dialog box where you

can select a design to open. Formats you can

open include Analytix/Cams files (*.cam), or

comma- or tab-delimited ASCII. If you open an

ASCII file with x,y or r,6 pairs separated by

carriage returns, the data will be automatically

inserted into the data table.

Save - Saves the current document using a

name you've previously defined.

Save As - Opens the Save As dialog box, which

allows you to name the document and determine

the format in which to save it. Formats include

DXF, CAM and tab-delimited ASCII.

Exit - Quits Analytix/Cams. If you have made

modifications to a previously saved document or

have not yet saved the document, you are given

that option.



Edit

Undo - Reverses the last action to its previous

state.

Redo - Works in conjunction with Undo to

reverse the Undo command.

Copy - Leaves the selected text in the document

and places a copy on the Clipboard for later

pasting.

Paste - Places the items on the Clipboard at the

insertion point in the document.

Options - Allows you to change the display

options of the Analysis area.

The drop down menu provides the following

options: Displacement, Velocity, Acceleration,

Jerk, Axes and Background.



Colors - 16 colors are supported in the color

palette. Select Displacement, Velocity,

Acceleration, and Jerk and select a color option

for that selection. 
When you select Background

or Axes in the drop-down menu and choose a

color in this palette, the same color applies to all

views in the Analysis area.

Line Thickness - Select from 1 to 8 point line

thickness.

Buttons - Click the appropriate button for the

desired grid type. Options include no grid,

horizontal or vertical grid or full grid.

Use the items in the Help menu as an electronic

reference to Analytix/Cams.

Help
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